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Copyrights and Trademarks
© 2006 Utah Scientific, Inc., All rights reserved. Any use or reproduction of this guide’s contents without 
the prior written consent of Utah Scientific, Inc. is strictly prohibited.

• rMan is a trademark of Utah Scientific, Inc.

• Windows 2000, NT, and XP are registered trademarks of Microsoft Corporation.

• All other product names and any registered or unregistered trademarks mentioned in this guide are 
used for identification purposes only and remain the exclusive property of their respective owners.

Notice
Information contained in this guide is subject to change without notice or obligation. While every effort 
has been made to ensure that the information is accurate as of the publication date, Utah Scientific, Inc. 
assumes no liability for errors or omissions. In addition, Utah Scientific, Inc. assumes no responsibility for 
damages resulting from the use of this guide.

FCC Compliance (USA) and Digital Equipment Compliance 
(Canada) 
This equipment has been tested and found to comply with the limits for a Class A, digital 
device, pursuant to Part 15, Subpart B of the FCC Rules and the Canadian EMC Requirement 
(ICES-003). These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful 
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interference, in which case, the user will be required to correct the interference at their own 
expense. Shielded cables must be used to ensure compliance with the FCC Class A limits.

Declaration of Conformity
Utah Scientific, Inc.

4750 Wiley Post Way, Suite 150
Salt Lake City, Utah 84116-2878  U.S.A.

We declare our sole responsibility that the rMan Control System is conformance with the following 
standards:

• EN50081-1 Generic Emission Standard

• EN50082-1 Generic Immunity Standard

• IEC-950 Product Safety

• C-UL 1950 Product Safety

• UL 1950 Product Safety

Following the provisions of the Directive(s) of the Council of the European Union:

• EMC Directive 89/336/EED

• Low Voltage Electrical Directive 72/23/EEC

Utah Scientific, Inc. hereby declares that the product specified above conforms to the above Directive(s) 
and Standard(s). 
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Important Safeguards and Notices
Important Safeguards and Notices
This section provides important safety guidelines for the Operator and Service Personnel.  Specific 
warnings and cautions are found throughout the guide where they apply, but may not appear here. 
Please read and follow the important safety information, specifically those instructions related to risk of 
fire, electric shock, or injury to persons.

Safety Symbols
• Hazardous Voltage symbol

• Caution symbol.  The product is marked with this symbol when it is necessary to 
refer to the manual to prevent damage to the product.

Warnings
Please observe the following important warnings:

• Any instructions in this guide that require opening the chassis, changing a 
power supply, or removing a board, should be performed by qualified personnel 
only. To reduce the risk of electric shock, do not perform any service unless you 
are qualified to do so.
• Heed all warnings on the unit and in the operating instructions.

• Do not use this product in or near water.  Disconnect AC power before installing 
any options or servicing the unit unless instructed to do so by this manual.

• This product is grounded through the power cord ground conductor. To avoid 
electric shock, plug the power cord into a properly wired receptacle before con-
necting the product inputs or outputs.

• Route power cords and other cables so they won’t be damaged.

• The AC receptacle (socket) should be located near the equipment and be easily 
accessible.

• Disconnect power before cleaning.  Do not use any liquid or aerosol cleaner - 
use only a damp cloth.
rMan Operations          iii



iv
• Dangerous voltages exist at several points in this product. To avoid personal 
injury, do not touch exposed conductors and components while power is on. Do 
not insert anything into either of the systems two-power supply cavities with 
power connected.

• Do not wear hand jewelry or watches when troubleshooting high current circuits, 
such as power supplies. During installation, do not use the door handles or front 
panels to lift the equipment as they may open abruptly and injure you.

• To avoid fire hazard when replacing fuses, use only the specified correct type, 
voltage and current rating as referenced in the appropriate parts list for this 
product.  Always refer fuse replacement to qualified service personnel.

• Have qualified personnel perform safety checks after any service. 

Cautions
Please observe the following important cautions:

• When installing this equipment do not install power cords to building surfaces. 
To prevent damage when replacing fuses, locate and correct the problem that 
caused the fuse to blow, before reconnecting power.
• Use only specified replacement parts

Notices
Please observe the following important notes:

• When the adjacent symbol is indicated on the chassis, please refer to the man-
ual for additional information.

• For the HD-2020 Chassis and Master Control Panel, refer to “Connecting and 
Disconnecting Power” - Chapter 2 (Hardware Installation). 
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Company Information
Company Information

Utah Scientific, Incorporated
4750 Wiley Post Way, Suite 150
Salt Lake City, Utah 84116-2878  U.S.A.

• Telephone: +1 (801) 575-8801

• FAX: +1 (801) 537-3098

• Technical Services (voice): +1 (800) 447-7204

• Technical Services (FAX):   +1 (801) 537-3069

• E-Mail -General Information: info@utsci.com

• E-Mail -Technical Services: service@utsci.com

• World Wide Web: http://www.utahscientific.com

• After Hours Emergency: +1 (800) 447-7204. Follow the menu instructions for Emergency Service.
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Warranty Policies

Hardware Warranty

Utah Scientific, Inc. warrants to the original purchaser that the Utah Scientific hardware is free 
from defects in materials and workmanship and will perform substantially in accordance with 
the accompanying written materials under normal use and service for a period of ten (10) years 
from the date of shipment. Any implied warranties on hardware are limited to ten (10) years. 
Some states/jurisdictions do not allow limitations on duration of an implied warranty, so the 
above limitation may not apply to certain specific purchasers.

Software Warranty

Utah Scientific warrants that the software will perform substantially in accordance with the 
accompanying written materials for a period of one (1) year from the date of shipment.

Customer Remedies

For the first one (1) year after purchase of the software and the first ten (10) years after the date 
of purchase of the hardware, Utah Scientific’s and its suppliers’ entire liability and purchaser’s 
exclusive remedy shall be, at Utah Scientific’s option, either:

• Return of the price paid, or

• Repair or replacement of the software or hardware that does not meet the above warranties 
and is returned to Utah Scientific under the returned materials authorization (RMA) 
process with freight and forwarding charges paid.

After the initial warranty periods, purchaser’s exclusive remedy is the repair or replacement of 
the hardware upon payment of a fixed fee to cover handling and service costs based on Utah 
Scientific’s then-current price schedule. The above warranties are void if failure of the 
software or hardware has resulted from an accident, abuse, or misapplication. Any replacement 
software or hardware will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer.

No other warranties. To the maximum extent permitted by applicable law, Utah Scientific and 
its suppliers disclaim all other warranties, either express or implied, including, but not limited 
to implied warranties of merchantability and fitness for a particular purpose, with regard to the 
software, the accompanying written materials, and any accompanying hardware. This limited 
warranty gives the purchaser specific legal rights. These rights may vary in certain states/
jurisdictions.
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Warranty Policies
No liability for consequential damages. To the maximum extent permitted by applicable law, 
in no event shall Utah Scientific or its suppliers be liable for any damages whatsoever 
(including without limitation, damages for loss of business profits, business interruption, loss 
of business information, or any other pecuniary loss) arising out of the use of or inability to use 
Utah Scientific products, even if Utah Scientific has been advised of the possibility of such 
damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability 
for consequential or incidental damages, the above limitation may not apply in those 
circumstances.
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Chapter 1 - The rMan

Interface

Introduction

This is essentially the introduction to the rMan Utility. 

System Overview 

The rMan Utility has been developed as a management tool for Utah 
Scientific's Router Operations. Once the SC-4 and control panels have 
been configured using the U-Con utility, rMAN is utilized for system 
status and maintenance. 

rMan can be used throughout the life of the facility’s router operations 
for effective observation and maintenance. The program is also 
designed to offer corrective ‘advice’ when certain problems develop. 
This may involve certain steps or specific corrective action to resolve 
conflicts.
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Chapter 1 - The rMan Interface
Installing rMan Software

Locate the system CD that should have been provided with the SC-4 controller. (If you do 
not have this CD, contact Utah Scientific Customer Support at 800-447-7204). On the CD 
you will find a folder called Install 2020. Open this folder and then open the folder called 
release-rMan. Double-click the setup.bat file -- this will install Java onto the PC (required), 
followed by the rMan application. 

Locate and double-click the rMan icon on the desktop to launch the program. 

Make sure an Ethernet connection exists between the SC-4/400 and the PC containing 
the rMan application. Follow the standard Ethernet protocol for the connection, using 
CAT5 cable. A crossover cable is required if running directly between the devices. 

Connection Parameters

FIGURE 1-1.

This is the first window that will appear when rMan is launched. Make sure the default IP 
address is correct, or enter the correct address at this time. 
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The following screen will appear once a connection has been established. 

FIGURE 1-2.

As you can see, all connection detail is minimized in the folder view (large white area). 

Status Bar
Located at the bottom of the display, the Status Bar displays the current connection activ-
ity. The green [up] arrow on the right side indicates an 'active' connection.

If the green arrow is not visible, establish a connection by selecting 'Connect' from the File 
menu, or by clicking the connect icon (just below the Control menu).
rMan Interface 1-3
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Main Screen

Typically the user will begin running rMan after the system is configured and running. 
The user is initially provided with the current alarm status and alarm history. 

FIGURE 1-3.

Once a connection has been established, you will see the IP address along the 
lower-left corner of the display, and a green (up) arrow in the lower-right corner. 

Alarm LEDs will display green initially, then turn red if any alarm conditions exist. 

Alarm Status
See Chapter 2 for more information regarding Alarm Status and History. 
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Graphical Status

Graphical Status is a powerful way to view router connections. 

Connection Lines

The lines you see connecting the right and left columns (devices) indicate an actual con-
nection between the Input device and an Output device through the router. The different 
colors have specific meanings:

Blue – Video connection

Green – Audio connection

Gray – Other kinds of connections (General), such as video and audio together. Data rout-
ing can also be black.

Red – This indicates a Tie Line connection. The red line also indicates tie line status.

FIGURE 1-4.
rMan Interface 1-5
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Constructing a Folder View within Graphical Status
The Folder View file modification is the process of organizing essential display activity into 
manageable directories (folders) for easier reference. You will start with the default flat 
view of the layout (Fig. 1-4) then construct new folders associated by Group Names. The 
file modification process consists of adding the appropriate HTML code to the beginning 
and end of each group block within your saved file (see illustration). The illustration will 
contain references to the start and stop points that will be used for the HTML markers. 

Flat View

The Flat View exists as a convenience for the user, as the operator is not required to 
create a file to start up. Specifically, when rMan is first run, there is no file associated 
with the view, so the system simply obtains default information from the SC-4 and cre-
ates a device listing. The user can save this information as a file for convenience.

Device format (analog or digital views)

Organizing Input and Output devices into folders helps to minimize clutter and gives a 
high-level, layered view of the router status. rMan gives you the ability to organize 
devices by geographic location within your facility. This is possibly the most useful way 
of viewing system status. Device management of this type can involve edit bays, con-
trol rooms, switchers, video areas, etc.

Folder View - File Construction
This guide contains an example of the finished (saved) XML file that you will be work-
ing with prior to creating the folder view. This XML file will contain the Input and 
Device name, along with all other applicable devices. You’ll use this file to essentially 
construct new groups into a better organized folder view. 

As mentioned, the file modification consists of adding the appropriate HTML code to 
the beginning and end of each group block (in the already saved XML file). This pro-
cess involves simply the copy and paste of a short text string at the beginning and end 
of given text blocks. This will be illustrated in our example. 
rMan Monitoring Utility
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Procedure
While in the flat view (Figure 1-4), select Close from the File menu. When this is done, all 
detail contained in the large white display area will minimize down to show only the Input 
and Output devices. 

FIGURE 1-5.

At this point return to the File menu and select Save. This will open a standard Save dia-
log that will default (for the save) to the last hard drive location. Name the file, and make 
sure you add a txt extension. Click OK to close the window. 
rMan Interface 1-7
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Next, close the rMan application completely, then open a text editor (such as 
Notepad) and open the just-saved file. The file will look similar to this: 

FIGURE 1-6.

Before proceeding, click ‘Save As’ from the File menu, and place an XML extension at 
the end of the file name. 

example: rman1.xml

It is at this point that you’ll add the proper HTML ‘open and ‘close’ text strings to the 
indicated text blocks. These HTML strings are easy to use, and if you have experience 
with HTML code you will already be familiar with them. In this exercise we will be 
breaking the devices you see listed above (Fig. 1-6) into manageable groups, so we’ll 
be placing group ‘open’ and ‘close’ markers at specific locations. These locations are 
determined by preference -- or where you would like the devices to start and end in 
each group. (See the next Figure). 
rMan Monitoring Utility
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The HTML string for ‘open’ group is

<group name=”VT”>

The “VT” in the above example is the VTR reference found in the original text file, and will 
appear in the finished rMan folder view. This could also refer to other devices, such as 
CAM, AUX, NT, etc. 

The HTML string for the ‘close’ group is

</group>

When complete, your edited text file should look similar to this:

FIGURE 1-7.

Notice that the devices are now separated into manageable group blocks. 

Now re-save this file (making sure the ‘XML’ extension is in place), re-launch rMan, then 
open the new file. 
rMan Interface 1-9
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You will now have a revised graphical folder view of your components, as opposed to 
the ‘flat’ view that was previously available. 

FIGURE 1-8.

You can organize different sets of devices within a facility, then place this listing in a 
view file for convenience. It is possible to have different views of the system by creat-
ing different files (above procedure). A file simply contains a definition as to how the 
view should look.
0 rMan Monitoring Utility
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Tabular Status
Tabular Status is the traditional way to view router status. Destination devices are dis-
played on the left, while connected source status is listed to the right.

FIGURE 1-9.

The above view contains the actual status of the names within the system, rather than 
graphical connections only. This includes the mnemonic names of each connection, with real 
time updates shown in the ‘Source Name’ column. 
rMan Interface 1-11
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The Device Number – Examined Further
The device number is associated with various ‘mappings’ that are taking place within 
the SC-4. Device numbers are in effect, markers that the SC-4 uses to place devices 
within the table. All items – whether they’re cameras, monitors, or anything else – get 
‘device numbers’ that are utilized during the switching process, and everything in the 
control panel contains a device number for switching purposes. 

Numbers are also ‘mapped’ to given ‘Levels’. The ‘mapping’ is a means for directing 
the signal to the appropriate crosspoint in the router, so that the switching can occur at 
the right place. 

Device Configuration
This table is an actual readback of the current Source and Destination list taken from 
the SC-4. This is a global crosspoint table that is used by all devices such as control 
panels, master control switchers, and automation programs attached to the SC-4. 
These devices all use the same index table that in turn, maps to the individual cross-
point numbers for the different level formats of video, audio, data routers, etc. 

Click the Source or Destination button (found in the Device Configuration table) to 
view the index table with its associated level crosspoints. 

FIGURE 1-10.
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Event Log

The Event Log is essentially a listing of all actions that have occurred. To locate this list-
ing, select Event Log from the View menu. (You can also select Event Log from the icon 
toolbar.)

Individual Messages
A ‘Take’ message will contain associated Device Numbers. The message will, in turn, indi-
cate what actual physical inputs and outputs switched on the Router. 

Within the Event Log, you can click on the Headings to sort them in a given manner. This 
procedure is helpful in searching for an individual event.

You have the ability to sort the headings in a column basis. When new events are acti-
vated, they will automatically drop to the bottom of the column in a scrolling fashion. New 
events can be viewed by scrolling to the bottom of the listing. 

Note: Note: New takes coming into the program display will be added at the 
bottom of the list. This can amount to a lot of activity within the list, 
making the location of older entries difficult. Use the toggle button to 
pause the Auto-Scroll. For convenience, this will keep the screen from 
updating and allow the user to scroll and search for specific entries.
rMan Interface 1-13
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Sorting
This is a new addition to the program, and you can sort by Event, Time, or by Details. 
Clicking any of the column buttons (top) gives you different sorting capabilities for that 
particular column detail. The arrow upward will place the most recent activity at the bottom 
of the column. The Event column can be sorted alphabetically; with an ‘arrow up’ sorting 
from A to Z, while the down arrow sorts Z to A. The default sorting method is down arrow. 
The most recent activity is displayed at the bottom of the list, and the oldest detail will 
appear at the top of the column display.

Pause Auto-Scroll
When clicked, program Takes are ‘still stored’ within the SC-4, but are not displayed (for 
scrolling) within the Log. This is useful because in active scrolling situations, detail is 
arriving in the log too quickly for there to be a coherent display. 
4 rMan Monitoring Utility
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Take Panel

The Take Panel provides a means for displaying the current status information for any of 
the controller's Inputs and Outputs. The Input, Output, and a Level selection must be 
made (bottom checkbox) to activate the Take button. When the Take button is clicked, a 
take is performed and current status for the last take (associated with the Input, Output, 
and Level) is displayed at the bottom of the dialog box. Selecting a different Output from 
the list causes the Take button to turn gray, indicating that the source box and levels 
check boxes are showing current status.

With a video encoder in place, the program provides a display for the selected Output in 
the large view area.

To use the viewer, attach the monitor output from the digital router to the encoder unit that 
is attached to the PC. To view a specific output, select it from the output dropdown box 
and then press the monitor button. 

Important: An Internet browser must be correctly mapped to the operating system 
for this utility to work properly. For the setup procedure, see next.
rMan Interface 1-15
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Mapping Verification
Mapping Verification is the method for activating your Internet browser, so that each time 
the rMan Take Panel is used your selected browser automatically appears. The following 
steps will cover the setup process; and will allow you to verify the browser currently in 
place, change the browser (selection), or add one if none currently exists. 

From the Start button, select Control Panel, then Printers and Other Hardware. Next, 
select ‘System’ (menu item on the left), the Advanced tab, then ‘Environment Variables’ 
(button near the lower-left area).

FIGURE 1-11.
6 rMan Monitoring Utility
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In the ‘System Variables’ window, scroll down until ‘Path’ is visible. Highlight ‘Path, then click 
the Edit button. 

FIGURE 1-12.

When the Edit window appears, go to the ‘Variable Value’ text box and type the following 
Immediately after the semi-colon:

FIGURE 1-13.

This is where the name of the current Internet browser needs to appear, immediately after the 
last semi-colon. If it is already there, do nothing. If there is no semi-colon and/or you do not 
see the name of the Internet browser, type the following:

c:\Program Files\Internet Explorer

(You can substitute Internet Explorer with another browser if you prefer.) 

When the above has been entered, click OK to close all dialog windows. 
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Returning to rMan After Mapping
You can now activate the Internet browser by accessing the Take Panel (Control menu). 

The above action allows the web page associated with the SC-4 control panel to launch. 
When you select the Take Panel, the user name and password entry dialog will appear.

These are currently set as defaults: admin for username and admin for password. Not 
changeable at present. 

Click the Login button (shown above). This will direct you to a sub-browser (dialog). The 
video output (if present) is the output of a decoder card, or the monitor output of the router. 
The actual video display is optional and is driven by a separate video card. 

The control area (lower portion of the screen) is essentially an Ethernet control panel, in 
sync with the SC-4. The input and output lists (dropdown menus), contains all current 
system devices. 
8 rMan Monitoring Utility
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Making Output selections, as an example, is simply a matter of highlighting the item from the 
dropdown menu. The Levels that are currently available for the selected output will appear 
under the dropdown list. 

You can highlight the levels you want to associate the Take to by clicking their associated 
checkboxes. Clicking the Take button will perform the actual switch. The switch will be 
confirmed in the bottom white bar (message area). 

Clicking the ‘Monitor’ button will switch the selected Output to the monitor bus for verification 
(viewing) purposes. 

Important to Note
It is not mandatory for rMan to be operating to achieve the above monitoring. 
Using the SC-4’s IP address, you can go directly to the SC-4’s web page and 
perform the same functions. Do this by selecting the (4th) item in the listing – 
SC-4 Router Control.
rMan Interface 1-19
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Chapter 2 - rMan Alarms

and Alerts

rMan Alarms

rMan monitors the alarm status, including the severity of the condition 
and the alarm’s history.1 

Alarm Status – Alarm Status is defined by the LEDs that are displayed 
on the interface. A red LED indicates a minor error, flashing red indi-
cates a major error, and a green LED indicates a cleared status. View 

Clicking the button next to the LED will provide specific status informa-
tion regarding the nature of the alarm. 

Alarm Types

Tie-Line Alarms
A Tie Line Alarm is likely the most frequent alarm you will encounter.Tie 
Lines support transparent signal conversion. Tie Lines are limited in 
number, and Tie Line alarms occur when the system has reached its 
capacity.

Groups of Tie Lines can be managed together as a ‘pool’, and when a 
tie line pool reaches its pre-configured alarm threshold, the alarm is 
produced. This will not be a major alarm since no critical operations are 
affected, but when the capacity is exceeded, the alarm status becomes 
major.

When a Tie Line alarm occurs, you will be prompted to find the current 
locations for tie line use, then disconnect the ones that are not neces-

1. Currently, the only alarms that are functional are the tielines and LOS alarms. 
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sary. You can determine what destinations are using tie lines by simply looking at the 
graphical interface and seeing where the red lines are connected.

Alarm History
The Alarm History reflects the ‘Life Cycle’ of an alarm condition. Meaning, an alarm 
will exist until the status is cleared and the user has clicked ‘Acknowledge’ on the dia-
log display.

If an alarm condition appears and later subsides without anyone verifying it, the alarm 
still exists as an ‘alarm condition’ until it is acknowledged. Once the alarm is acknowl-
edged and cleared, it then will assume a ‘green’ or cleared status. The program pro-
vides a count of the total number of times an alarm has occurred before being 
acknowledged. 

Alarm events also appear in the Event Log as line items

Email Alerts
rMAN can automatically send email alerts any time an alarm event occurs. The list of 
recipients is definable within the program. 

Email Configuration
A listing of email addressed (for the alert notification) is configured within the SMPTE 
mail server.

Addresses are either enabled or disabled at this location. To add a new email 
address, just type the new address in the provided window and click Add. The com-
plete list of addresses will appear in the larger window (illustration on right). You can 
rMan Monitoring Utility
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also designate the Server Name you will be using for Email. Changes made are saved in 
the rMAN settings file. 
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